
 
 

 

 
MPI-1600 
User Manual 
 
THE NEW GENERATION OF POWER CONVERTERS 

• DUAL AC AND DC OUTPUT CONVERTER 
Commercial Power as default source 

 

• AC AND DC BACKUP IN A DC ENVIRONMENT 
Leverage your existing DC infrastructure 

 

• ONE STOP SHOP 
Wide output power range 

 

• MILITARY AC INPUT CONDITIONS 
Without compromising the quality of the AC output 

 

• HARSHEST ENVIRONMENT CONDITIONS 
Product for extreme MIL-STD-810G environment conditions 

 

 

Version 1.1 

Australia
sales-au@heliosps.com
+61 2 7200 9200

Asia 
sales@heliosps.asia
+65 6871 4140

New Zealand 
sales-nz@heliosps.com
+64 9 835 0700 

Middle East 
sales@heliosps.asia
+971 4 401 8484

heliosps.com

mailto:sales-au%40heliosps.com?subject=
mailto:sales%40heliosps.asia?subject=
mailto:sales-nz%40heliosps.com?subject=
mailto:sales%40heliosps.asia?subject=
https://heliosps.com


2 – MPI-1600 – User Manual 
– v1.0 

 

 

Table of content   
1. CE+T Power at a glance ................................................................................................................... 5 

2. Abbreviations ................................................................................................................................... 6 

3. Warranty and Safety Conditions
*
 ....................................................................................................... 7 

3.1 Disclaimer ............................................................................................................................... 7 
3.2 Technical care ........................................................................................................................ 7 
3.3 Installation .............................................................................................................................. 7 
3.3.1 Handling ...................................................................................................... 8 
3.3.2 Surge and transients .................................................................................. 8 
3.3.3 Other ............................................................................................................ 8 
3.4 Maintenance ........................................................................................................................... 9 
3.5 Replacement and Dismantling ............................................................................................... 9 
4.1 AC-AC mode ........................................................................................................................ 11 
4.2 DC-AC mode ........................................................................................................................ 11 

5. Basic Information ........................................................................................................................... 12 
5.1 MPI-1600 .............................................................................................................................. 12 
5.1.1 MPI-1600 Specifications ........................................................................... 12 
5.1.2 Converter - LED Indications ..................................................................... 14 
5.2 Inview XC (RIPE) ................................................................................................................. 15 
5.2.1 Inview XC (RIPE) Specifications .............................................................. 15 
5.3 Accessory - Bridging COM plug (Optional) .......................................................................... 16 

6. Installation ...................................................................................................................................... 17 
6.1 MPI-1600 dimensions .......................................................................................................... 17 
6.2 Front Panel Connectors ....................................................................................................... 18 
6.2.1 Pin Assignment ......................................................................................... 18 
6.3 Remote ON/OFF .................................................................................................................. 19 
6.4 Wall mounting ....................................................................................................................... 20 
6.5 Cable sizing .......................................................................................................................... 20 
6.5.1 DC input connection ................................................................................. 20 
6.5.2 AC input connection ................................................................................. 20 
6.5.3 AC output connection ............................................................................... 20 
6.6 Grounding ............................................................................................................................. 21 
6.7 Hardware Connections ......................................................................................................... 21 

7. Monitoring device - Inview XC (RIPE) .............................................................................................. 22 
7.1 Inview XC (RIPE) dimensions .............................................................................................. 22 
7.3 Inview XC (RIPE) Installation ............................................................................................... 23 
7.3.1 Site preparation ......................................................................................... 23 
7.3.2 Wall mounting ........................................................................................... 23 
7.4 Hardware Connections ......................................................................................................... 24 
7.4.1 Output Relay Connections ....................................................................... 25 
7.4.2 Digital Input Connections ......................................................................... 25 

Australia
sales-au@heliosps.com
+61 2 7200 9200

Asia 
sales@heliosps.asia
+65 6871 4140

New Zealand 
sales-nz@heliosps.com
+64 9 835 0700 

Middle East 
sales@heliosps.asia
+971 4 401 8484

heliosps.com

mailto:sales-au%40heliosps.com?subject=
mailto:sales%40heliosps.asia?subject=
mailto:sales-nz%40heliosps.com?subject=
mailto:sales%40heliosps.asia?subject=
https://heliosps.com


3 – MPI-1600 – User Manual 
– v1.0 

 

 

8. Inview web interface ....................................................................................................................... 26 
8.1 Connection to Inview web interface ..................................................................................... 26 
8.2 Navigating through the interface .......................................................................................... 26 
8.2.1 Header ....................................................................................................... 26 
8.2.2 Web page Controls ................................................................................... 28 
8.3 Inview Licenses .................................................................................................................... 29 
8.3.1 Basic License ............................................................................................ 29 
8.3.2 Specific licenses ....................................................................................... 30 
8.4 Network settings ................................................................................................................... 30 
8.5 System configuration ............................................................................................................ 31 
8.5.1 Converter system configuration .............................................................. 31 
8.5.2 DC system configuration .......................................................................... 34 
8.5.3 Widget configuration ................................................................................ 36 

9. Finishing ........................................................................................................................................ 41 

10. Commissioning .............................................................................................................................. 42 
10.1 Check list .............................................................................................................................. 43 

11. Trouble Shooting and Defective Situations Fixing.............................................................................. 44 
11.1 Trouble Shooting .................................................................................................................. 44 
11.2 Defective modules ................................................................................................................ 45 

12. Maintenance .................................................................................................................................. 46 
12.1 Access Inview XC (RIPE) with Laptop ................................................................................. 46 
12.2 Manual check ....................................................................................................................... 46 
12.3 Optional ................................................................................................................................ 46 
12.4 Manual By-Pass ................................................................................................................... 46 

13. Defective modules .......................................................................................................................... 47 

14. Appendix ........................................................................................................................................ 48 
14.1 Modules - Parameter List ..................................................................................................... 48 

 

Australia
sales-au@heliosps.com
+61 2 7200 9200

Asia 
sales@heliosps.asia
+65 6871 4140

New Zealand 
sales-nz@heliosps.com
+64 9 835 0700 

Middle East 
sales@heliosps.asia
+971 4 401 8484

heliosps.com

mailto:sales-au%40heliosps.com?subject=
mailto:sales%40heliosps.asia?subject=
mailto:sales-nz%40heliosps.com?subject=
mailto:sales%40heliosps.asia?subject=
https://heliosps.com


4 – MPI-1600 – User Manual 
– v1.0 

 

 

Release Note: 
 

Version 
Release date 
(DD/MM/YYYY) 

Modified page 
number 

Modifications 

1.0 24/04/2024 - First Release. 

1.1 28.06.2024    RIPEnergy  release 

    

    

    

Australia
sales-au@heliosps.com
+61 2 7200 9200

Asia 
sales@heliosps.asia
+65 6871 4140

New Zealand 
sales-nz@heliosps.com
+64 9 835 0700 

Middle East 
sales@heliosps.asia
+971 4 401 8484

heliosps.com

mailto:sales-au%40heliosps.com?subject=
mailto:sales%40heliosps.asia?subject=
mailto:sales-nz%40heliosps.com?subject=
mailto:sales%40heliosps.asia?subject=
https://heliosps.com


5 – MPI-1600 – User Manual 
– v1.0 

 

 

1.  CE+T Power at a glance  
CE+T Power is your trusted partner in advanced power solutions engineered to meet the demands 

of modern and dynamic industrial applications. With over 60 years of experience in power 

conversion technology, CE+T Power nurtures the industry with innovative solutions designed for 

critical power backup and energy management. 

 

 
Our complete range of power solutions includes modular inverters (DC to AC), UPS (securing AC 

loads with batteries), and multidirectional converters (inverter, rectifier, and UPS all-in-one). 

Coupled with our state-of-the-art monitoring solution, you have a real energy blender to connect 

multiple sources of energy seamlessly! 

 

 
Whether you require robust backup power solutions, energy management solutions, or a 

combination of both, CE+T Power delivers tailored solutions to meet your specific needs. Our 

products are designed with integration in mind, ensuring seamless compatibility with other 

components of your system. CE+T Power is committed to providing you with the expertise and 

resources needed to maximize the performance of your power systems. 

 

 
Thank you for choosing CE+T Power as your partner in advanced power management. Let’s power 
the future together. 
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2.  Abbreviations  
 

AC Alternating current 

AL Alarm 

DC Direct current 

DHCP Dynamic Host Configuration Protocol 

DSP Digital Signal Processor 

ECI Enhanced Conversion Innovation 

EPC Enhanced Power Conversion 

ESD Electro Static Discharge 

ETH Ethernet 

HTTP HyperText Transfer Protocol 

HTTPS Secure HyperText Transfer Protocol 

LAN Local Access Network 

LVD Low Voltage Disconnect 

MBB Measure Box Battery 

MBP Manual By-pass 

MET Main Earth Terminal 

MIB Management Information Base 

N Neutral 

NTP Network Time Protocol 

NT/KO Not Okay 

NUA Non-Urgent Alarm 

PCB Printed Circuit Board 

PE Protective Earth (also called Main Protective 
Conductor) 

PWR Power 

REG Regular 

SNMP Simple Network Management Protocol 

TCP/IP Transmission Control Protocol/Internet 
Protocol 

TRS True Redundant Structure 

UA Urgent Alarm 

UMB Universal Measure Box 

USB Universal Serial Bus 
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3. Warranty and Safety Conditions* 

3.1 Disclaimer 

• The manufacturer declines all responsibilities if equipment is not installed, used or 

operated according to the instructions herein by skilled technicians according to local 

regulations. 

• Warranty does not apply if the product is not installed, used or handled according to the 

instructions in the manual. 

• This equipment is shipped with a SHOCKWATCH monitor. If the SHOCKWATCH shows 

that the equipment was exposed to excessive force the warranty will be void. 

 

3.2 Technical care 

• This electric equipment can only be repaired or maintained by a “qualified employee” with 

adequate training. Even personnel who are in charge of simple repairs or maintenance are 

required to have knowledge or experience related to electrical maintenance. 

• Please follow the procedures contained in this Manual, and note all the “DANGER”, 

“WARNING” AND “NOTICE” marks contained in this Manual. Warning labels must not be 

removed. 

• Qualified employees are trained to recognize and avoid any dangers that might be present 

when working on or near exposed electrical parts. 

• Qualified employees know how to lock out and tag out machines so the machines will not 

accidentally be turned on and injure employees working on them. 

• Qualified employees also know safety related work practices, including those by OSHA 

and NFPA, as well as knowing what personal protective equipment should be worn. 

• All operators are to be trained to perform the emergency shut-down procedure. 

• Never wear metallic objects such as rings, watches, or bracelets during installation, service 

and maintenance of the product. 

• Insulated tools must be used at all times when working with live systems. 

• When handling the system/units pay attention to sharp edges. 

• This product is suitable for use in a computer room. 

 

3.3 Installation 

• This product is intended to be installed only in restricted access areas as defined by local 

regulations and in accordance with the National Electric Code, ANSI/NFPA 70, or 

equivalent agencies. 

• The Converter System may contain output over current protection in the form of circuit 

breakers. In addition to these circuit breakers, the user must observe the recommended 

upstream and downstream circuit breaker requirements as defined in this manual. 

• Please use extreme caution when accessing circuits that may be at hazardous voltages or 
energy levels. 

• The modular converter rack is a dual input power supply. The complete system shall be wired 

in a way that both input and output leads can be de-energized when necessary. 

 

* These instructions are valid for most CE+T Products/Systems. Some points might however not be valid for 

the product described in this manual. 
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• REG systems and EPC systems that have no AC input wired and connected can be seen as 

independent power sources. To comply with local and international safety standards N 

(input) and PE shall be bonded. The bonded connection between N (input) and PE must be 

removed once the AC input is connected. 

• AC and DC circuits shall be terminated with no voltage / power applied (de-energized). 

• The safety standard IEC/EN62040-1-1 requires that, in the event of an output short circuit, the 

converter must disconnect in 5 seconds maximum. The parameter can be adjusted on Inview; 

however, if the parameter is set at a value > 5 seconds, an external protection must be 

provided so that the short circuit protection operates within 5 seconds. Default setting is 60 

seconds. 

• The system is designed for IP65 environment. 

• Environment Conditions: 

■ Storage Conditions: -50 to 70°C 

■ Relative Humidity: 95%, non-condensing 

■ Altitude above sea without de-rating: Less than 2000 m 

Greater than 2000 m – derated to 40°C 

• All illustrations in the manual are for general reference, refer to the technical drawing which 

is received along with the system for exact information. 

 

3.3.1 Handling 

• The cabinet shall not be lifted using lifting eyes. 

• Remove weight from the cabinet by unplugging the converters. 

 

3.3.2 Surge and transients 

The mains (AC) supply of the modular converter system shall be fitted with Lightning surge 

suppression and Transient voltage surge suppression suitable for the application at hand. 

Manufacturer’s recommendations of installation shall be adhered to. Selecting a device with an 

alarm relay for function failure is advised. 

Indoor sites are considered to have a working lightning surge suppression device in service. 

• Indoor sites Min Class II. 

• Outdoor sites Min Class I + Class II or combined Class I+II. The modular converter 

system/rack can reach hazardous leakage currents. Grounding must be carried out prior to 

energizing the system. Grounding shall be made according to local regulations. 

Note: 

Choosing and installing surge arrestors must obey to precise technical rules. Distance to equipment 

to protect, cable gage and cable routing have significant influence on proper device service. 

Some areas are more susceptible to be hit by electrical strikes, especially when 

altitude increases. Good earthing is also crucial for surge arrestors to work properly. 

CE+T declines any liability in regard to damaged caused to equipment not correctly or not sufficiently 
protected. 

 

3.3.3 Other 

• Insulation test (Hi-Pot) must not be performed without instructions from the manufacturer. 
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3.4 Maintenance 

• The converter system/rack can reach hazardous leakage currents. Earthing must be 

carried out prior to energizing the system. Earthing shall be made according to local 

regulations. 

• Prior to any work conducted to a system/unit, make sure that AC input voltage and DC 

input voltage are disconnected. 

• Prior to accessing the system or modules, make sure all source of supply is disconnected. 

CAUTION – Risk of electric shock. Capacitors store hazardous energy. Do not remove cover 

until 5 minutes after disconnecting all sources of supply. 

• Some components and terminals carry high voltage during operation. Contact may result in fatal 
injury. 

 

3.5 Replacement and Dismantling 

• ESD Strap must be worn when handling PCB’s and open units. 

• The converter system/rack is not supplied with internal disconnect devices on input nor output. 

• CE+T cannot be held responsible for disposal of the converter system and therefore the 

customer must segregate and dispose of the materials which are potentially harmful to the 

environment, in accordance with the local regulations in force in the country of installation. 

• If the equipment is dismantled, to dispose of its component products, you must comply with 

the local regulations in force in the country of destination and in any case avoid causing any 

kind of pollution. 

To download the latest documentation and software, please visit 

our website at www.cet-power.com 
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4. ECI Technology1 
A MPI-1600 module is a triple port converter built with ECI technology. This module delivers pure 

sinusoidal output and ripple free DC output from battery or AC mains. 

The below block diagram gives an explicit description of the topology and its operation. 
 

ECI technology has AC to DC, DC to AC, and DC to DC converters to provide constant and 

disturbance-free output power regardless of the input source. 

The power flows either from AC or DC source under the control of the DSP controller. Thanks to the 

module’s internal energy buffering, transferring the load between two input sources is achieved in 0 

ms. 

ECI can detect short circuit conditions at the AC output level. It will provide high current to clear the 

fault, and thus keeping other critical loads in operation. 

MPI-1600 module works on True Redundant Structure (TRS) that features decentralized, 

independent logic, and redundant communication bus. 

Each MPI-1600 module has three levels of protection, and it will help to isolate from other modules 

in case of any fault in the corresponding module. Due to this functionality in each module, it 

provides no single point of failure in modular systems. 

The MPI-1600 modular systems provide quality output power with higher efficiency. 
 
 
 
 
 
 
 
 

 
1 Information and data given in this chapter is intended to serve as an overview of the ECI Technology. Detailed features and 

parameters for each individual module type in the range may differ and should be referred to in the dedicated data sheet. 
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4.1 AC-AC mode 

In EPC mode, the AC Mains is the primary source and DC source works as a backup. When AC 

mains is present, the MPI-1600 module takes energy from the AC source and feed to: 

• AC Load via a double conversation to provide a pure sine wave. 

• DC load and also charges the battery with a regulated DC. 
 
 
 
 
 
 
 
 
 
 

 
The total output power of a module can be shared between the AC load, DC load and charging power 

based upon the requirement. 

If the AC source is not present, the module seamlessly switches to DC source without impacting the 

critical loads and resumes to EPC mode once AC source returns. The transfer time between AC to 

DC and DC to AC is 0 ms. 

The EPC mode provides a higher efficiency of ≥ 96% without compromising the purity of the output 
sine wave. 

 
 

 

4.2 DC-AC mode 

In back up mode, module operates in DC source and feed to: 

• AC Load via a double conversation to provide a pure sine wave. 

• DC load directly. 

• Measure Box Battery (MBB) is used for DC power calculation. 
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5.  Basic Information  

5.1 MPI-1600 
 

Telecom / Datacom: Input 28 Vdc 

230 Vac, 50/60 Hz 

 

 

 Output 230 Vac and 28 
Vdc 

 
Power 2000 VA / 1600 W 

• The MPI-1600 converter is a triple port converter. 

• Each converter can supply 1600 W on any DC, AC or combination of both AC and DC 

output ports. AC output load is the highest priority. Even if AC output is fully loaded (1600 

W), still 200 W is available for DC output. 

• The LEDs on the top indicate the converter status and output power. 

• Module is equipped with soft start. 

• 658 mm (D) x 293 mm (W) x 88 mm (H). 

• 14 Kg. 

 

5.1.1 MPI-1600 Specifications 
 

Model MPI-1600 

Part Number T7317200000 

Cooling Natural convection 

MTBF 200 000 hrs (MIL-217IF) 

Dielectric strength DC/AC 4300 Vdc 

RoHS Compliant 

 
Operating T° / Relative Humidity (RH) non-
condensing 

Tested according ETSI 300-019-1-4 class 4.1E 

-40°C to +70°C derating above 50°C / 0-95% 

Designed to sustain 10 x 24h-cycles - Method 

507.5 Procedure II (Figure 507.5-7) - MIL-

STD-810G 

Storage T° / Relative Humidity (RH) non-
condensing 

According to ETS 300 019-1-1 from -50°C upto 

+70°C / 0 to 95% 

 
Shock 

Designed to withstand according to MIL-STD-

810G, Method 516.6, Procedure I according 

following levels: Peak acceleration: 40 g 

Shock duration: 11 ms 

 
Vibration 

Designed to withstand according to ETSI EN 

300 019-1-5 Class 5M3 according Method 

514.6D Procedure I, Ground Vehicle Category 

20 Wheeled/Tracked/Trailer from MIL- STD-

810G 

Material (casing) Aluminium 

AC Input Data 

Nominal voltage / current 230 Vac / 7.2 A 
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Voltage range 

90 - 295 Vac (Derating below 125 Vac) 

Note: Derating on components not guaranteed 

above 265 Vac 

Brownout 
900 W @ 90 Vac / 1600 W @ 125 Vac linear 

decreasing @ 50°C 

Power factor / THD > 0.99 / < 3% 

Frequency (Synchronization range) 50 Hz (47 - 53 Hz) or 60 Hz (57 - 63 Hz) 

DC Input Data 

Nominal voltage (range) 28 Vdc (16 - 32 Vdc) 

Nominal current (at 1600 W output) 72 A 

Maximum input current (for 15 seconds) 

/ voltage ripple 
116.4A @ 22V /<10mV RMS 

AC Output Data 

Efficiency AC to AC / DC to AC > 96% / 93% 

Nominal voltage (Adjustable) 230 Vac (100 - 240 Vac) (Derating below 125 Vac) 

Frequency / frequency accuracy 50 or 60 Hz / 0.03% 

Nominal Output power 
2000 VA / 1600 W @230 V 

1500 VA / 1200 W @120 V 

Short time overload capacity 150% (15 seconds) 

Admissible load power factor Full power rating from 0 inductive to 0 capacitive 

Total harmonic distortion (resistive load) < 3% 

Load impact recovery time (10% - 90%) ≤ 0.4 ms 

Nominal current 
8.7 A @ 230 Vac 

12.5 A @ 120 Vac 

Crest factor at nominal power 3 : 1 for load P.F. ≤ 0.7 

Short circuit current 22.5 A for 15 seconds 

AC output voltage stability ±1% from 10% to 100% load 

DC Output Data 

Nominal voltage (Adjustable) 26.5 Vdc (16 - 32 Vdc) 

Maximum power 1600 W 

Maximum current at 24 Vdc 67 A 

Reverse polarity protection Yes 

Efficiency AC to DC > 93% 

In Transfer Performance 

Max. Voltage interruption / total transient 

voltage duration (max) 
0 sec / 0 sec 

Signalling & Supervision 

Monitoring device / Part Number INVIEW XC (RIPE) / T602004141 

Safety & EMC 

Safety EN60950 

 
EMC 

MIL-STD-461G ( CE102, RE102, RE102, 

CS101, CS114, CS115, CS116, RS103 ) / 

CISPR22 Class B / VG95373 / EN 61000-4-2 / 

EN 61000-4-6 Level 3 / EN 61000-3-2 / MIL-

STD-1275E 
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AC IN  DC IN AC OUT 25% 50% 75% 

CONVERTER 
STATUS 

CONVERTER 
OUTPUT POWER 

DC and/or AC 

 
5.1.2 Converter - LED Indications 

 

TOP VIEW 

 

FRONT VIEW 
 

Converter Status LED Description Remedial action 

OFF No input power or forced stop Check environment 

Permanent green Operation  

Blinking green 
Converter OK but working 

conditions are not fulfilled to 

operate properly 

 

Blinking green/orange alternatively 
Recovery mode after 

boost (8 In short circuit 

condition) 

 

Permanent orange Starting mode  

Blinking orange Modules cannot start Check Inview 

Blinking red Recoverable fault  

Permanent red Non recoverable fault Send module back for repair 

 

Output Power (redundancy not counted) 

<5% 
5% to 

40% 

40 to 

70% 

80 to 

95% 
100% 

100% = 

overloa
d 

Output Power (redundancy not counted) 

o x x o x x o o x x o o o o o o o o Status output power LED 

1B 1P 2P 2P 3P 3B Behaviour (B = Blinking, P = Permanent ) 
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5.2 Inview XC (RIPE) 

Inview XC (RIPE) is an advanced monitoring and controller unit especially suited for MPI-1600 

power systems. It allows the user to easily access the system information through the web interface 

and SNMP protocol. 

The Inview XC (RIPE) interface provides the user to access the configuration and setup files of the 

modules in the system. Like the other Inview interfaces, it is also a controller for DC regulation. 

Inview XC (RIPE) is featured with the following: 

• Monitors up to 32 converters. 

• Three LEDs to indicate Major alarm, Minor alarm and System Status. 

• Two Digital Inputs and two Output Relay contacts. 

• Higher temperature resistance. 

 

5.2.1 Inview XC (RIPE) Specifications 

 

Model Inview XC (RIPE) 

Modules Compatibility MPI-1600 

Display None (IP67 protected) 

Hardware interfaces 1 x ETH, 1 x RS485, 1 x CAN, 1 x 19 Pin 
connector 

Supported protocols 
Modbus RS485, Modbus TCP, SNMP v1, v2C and 

v3, HTTP/ HTTPS 

Digital input / Output relay 2 / 2 

Accessories Measure Box Battery (MBB) with external power 
supply 

Buzzer None 

Mounting Pole / Wall / Panel / Door 

Power supply Internal power supply 12 Vdc (from modules) 

Power consumption 5 W 

Operating Temperature Range -40 to 65 °C 

Dimension (WxHxD) 300 x 155 x 70 mm 

Weight 2.5 kg 

Part number T602004141 

 
For more information, refer to the Inview User Manual - https://datasheet.cet-power.com/CET - 

Monitoring - User  Manual - Inview - EN.pdf. 
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5.3 Accessory - Bridging COM plug (Optional) 

A 'Bridging COM Plug' is used to bridge the Remote A pin and GND pin, when Remote ON/OFF 

function is not used. The Rem A and GND pins are internally bridged inside this plug. This can be 

ordered separately from CE+T. 

Note: If the Bridging COM Plug is used, that particular COM port is not usable anymore. The 

secondary COM port can be used for other signals. 
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6.  Installation  
• Read safety instructions prior starting any work. 

 

6.1 MPI-1600 dimensions 
 

270 
 
 
 
 
 
 

 
FRONT VIEW 

 
657 

 
 

LEFT VIEW 

 

293 

 
 

TOP VIEW 

Width = 293 

mm Height = 

88 mm Depth 

= 657 mm 

 
 
 
 

 

ISOMETRIC VIEW 

 

8
8
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6.2 Front Panel Connectors 

 

6.2.1 Pin Assignment 

AC Input: 

A - Line 

B - Neutral 

C - Safety ground 
 

 
AC Output: 

A - Line 

B - Neutral 

C - Safety ground 
 

 
DC: 

A - DC positive 

B - DC negative 

 

COM: 

1 - Bus A 

2 - Bus A- 

3 - Remote K 

4 - Ground 

5 - (+)12 V 

6 - Remote A 

7 - Bus B 

8 - Bus B- 

 
 
 
 

 
Warning: The internal RS485 BUS comes in 

COM connector. The internal bus 

connectors are sensitive and special caution 

must be taken during installation, to keep 

them out of harms way. 
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6.3 Remote ON/OFF 

The remote ON/OFF connection is present within COM port. Refer to “6.2.1 Pin Assignment”, 

page 18 for more details. 

• The function of remote ON/OFF is used turn off the module/system output. 

• AC and DC inputs are not affected by the remote ON/OFF function. 

• The remote ON/OFF can be operated from any module when many modules are connected in 
parallel. 

• The remote ON/OFF requires changeover relay/contactor, one input opens as 

the other close. If both transitions are not picked up the status is not 

changed. 

• When DC input is only present, Remote ON/OFF will switch OFF the module input & output 

and enter the standby mode. Standby mode power consumption shall be <= 1 W. 

Relay/Contactor characteristics for Remote ON/OFF 

• Signal voltage +5 VDC (galvanic insulated) 

• Max wire size 1 mm2
 

Functional table for remote ON/OFF function 
 

# Rem K - GND Rem A - GND Status Indication 

1 Open Open Normal operation All (Green) 

 
2 

 
Closed 

 
Open 

 
OFF 

AC output 

(OFF) AC 

Input (Green) 

DC Input 

(Green) 

3 Open Closed Normal operation All (Green) 

4 Closed Closed Normal operation All (Green) 

Warning: If remote ON/OFF is not used, pins 4 and 6 (Remote A and GND) MUST 

be bridged together. It can be done at the customer-end of the COM cable that is 

connected to the COM port of MPI-1600. It can also be done using the accessory 

‘Bridging COM Plug’. Refer Section 5.3, page 16 for more details. 

If more than one MPI-1600 module is used in parallel and their COM ports are 

interconnected, then the bridging can be done at any one common junction. 
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6.4 Wall mounting 

 
 

 

 

 
• Clean the wall surface 

• Mark six hole positions on the wall according to the picture (dimensions in mm). 

• Drill holes on the marked points. 

• Fix the module on the wall, using the screws. 

Note: When installing multiple modules, minimum clearance of   mm must me maintained between 
the modules. 

 

6.5 Cable sizing 

6.5.1 DC input connection 
 

Model DC input current at 28 Vdc DC breaker Cable size Max size 

2000 VA 72 A 100 A 16 mm2
 16 mm2 per pole 

 
6.5.2 AC input connection 

 

Model Input current at 230 Vac AC breaker Cable size Max size 

2000 VA 7.2 A 10 A 2.5 mm2
 4 mm2

 

 
6.5.3 AC output connection 

 

Model Input current at 230 Vac AC breaker Cable size Max size 

2000 VA 8.7 A 10 A 2.5 mm2
 4 mm2
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6.6 Grounding 

“PE CHASSIS GROUND”  shall be wired to MET or distributed earth bar connected to MET, 

according to local regulations. 

 

6.7 Hardware Connections 

In MPI-1600 module, the Inview XC (RIPE) must be connected according to the following steps: 

1. Connect “COM” port in MPI-1600 System and “CE+T COM” port in Inview X using RJ45 straight 
cable. 

2. Connect “CAN ISO RS485” port in Inview XC (RIPE) and “CAN1” port in MBB. 
 

 

COM 

DC IN & Out 

1 
CE+T COM
 ET
H 

RJ45 Cable 

MPI-1600 
 

Inview XC 
(RIPE) 

AC Out   

AC IN 
 CAN 

Others (19 Pin) ISO 
RS485 

Australia
sales-au@heliosps.com
+61 2 7200 9200

Asia 
sales@heliosps.asia
+65 6871 4140

New Zealand 
sales-nz@heliosps.com
+64 9 835 0700 

Middle East 
sales@heliosps.asia
+971 4 401 8484

heliosps.com

mailto:sales-au%40heliosps.com?subject=
mailto:sales%40heliosps.asia?subject=
mailto:sales-nz%40heliosps.com?subject=
mailto:sales%40heliosps.asia?subject=
https://heliosps.com


22 – MPI-1600 – User Manual 
– v1.0 

 

 

300 

 
 
 
 
 
 

 
70 

260 

7.  Monitoring device - Inview XC (RIPE)  
MPI-1600 can be monitored through Inview XC (RIPE). The Inview XC (RIPE) has IP65 protection. 

 

In Inview XC (RIPE), the connection to CE+T COM, CAN ISO RS485, and ETH ports must be 

connected through the IP65 connector. 

The Alarm, Digital inputs, Customer CAN and USB connection, must be connected to Inview XC 

(RIPE) through the below connector. Refer to “7.4 Hardware Connections”, page 24 for pin details. 

 

7.1 Inview XC (RIPE) dimensions 

RIGHT VIEW FRONT VIEW LEFT VIEW 

 

 
ISOMETRIC VIEW 

TOP VIEW 
 

1
2
5
 

1
5
5
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7.2 Inview XC (RIPE) - LED Indications 

Three LED’s are present at top side of the controller to indicate major alarm, minor alarm, and system 
status. 

 
 
 
 
 
 

 
Red: Major 

Alarm Orange: 

Minor Alarm 

Green: System status (Normal Operation) 
 
 
 

 

7.3 Inview XC (RIPE) Installation 

7.3.1 Site preparation 

• Before mounting the Inview XC (RIPE) in the system, route all the required connection 

cables from the system and place them near the Inview XC (RIPE) mounting location. 

• All cables should be copper wire and must be rated for min 90°C (194°F). 

• All cables must be sized according to the rated current of the Inview / Measure Box Battery 

and to the customer terminal connection. 

• All power and signal cables should be routed properly. 

 

7.3.2 Wall mounting 

• Clean the wall surface. 

• Mark four holes according to the dimensions given in the picture below. 

• Drill holes on the marked points. 

• Fix the controller on the wall using the screws. 
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INVIEW XC (RIPE) 

24 – MPI-1600 – User Manual – v1.0 

PIN DETAILS  
NOT 

APPLICABLE 

ALARMS 

USB 
 

 
M 

L A 

 
K U N B 

 
J T V P C 

 
H S R D 

 
G E 

F 
 
 
 
 
 
 
 
 
 

 

DIGITAL 

INPUTS ISO_CAN 

A NA 

B +5 V USB 

C USB_OTG1_DN 

D USB_OTG_DP 

E CANH_I 

F D2 (+) 

G D2 (-) 

H D1 (-) 

J K1 (C) 

K K1 (NO) 

L K2 (NC) 

M K2 (NO) 

N NA 

P DGND 

R CANL_I 

S D1 (+) 

T K1 (NC) 

U K2 (C) 

V SHEILD 

 

 
 
 

 
 
 

 
 
 

 
 
 

 

 

12345678 

 
 

 
  

PIN DETAILS 

1 

2 

3 

4 

5 

6 

7 

8 

CAN H 

CAN L 

CAN GND 

Modbus B 

Modbus A 

NOT USED 

NOT USED 

Modbus GND 

 

 
7.4 Hardware Connections 

This section describes the hardware connections of the Inview controllers and some measure boxes 
(MBB/UMB). 

• CE+T COM port is dedicated to establish connection between Inview XC (RIPE) and converters. 

• ETH port: used for network connectivity and user can access the system information in the 

Web Interface and SNMP. The default static IP address is 10.250.250.1/24. 

• CAN / ISO RS485 port: for Modbus RTU and CAN communication. This port should be used 

for the communication with a Measure Box Battery. An external power supply is needed for 

the Measure Box Battery. To know about the pin details, refer to the following figure. 

• An “Others” port that comprises: 

■ Digital inputs (D1 and D2): Two potential free Digital Inputs are available for customer 
connections. 

○ Digital Input 1 is assigned for MBP operation if used. 

○ Digital Input 2 is assigned for Surge Arrester if used. 

■ Output relays (K1 and K2): Two output relays are available and can be used for Major and 
Minor alarms. 

■ An additional iso CAN for CAN communication. 
 

PIN DETAILS 
 

 

 

 

1 BUS A 

2 BUS A- 

3 REMOTE K 

4 GND 

5 +12 V 

6 REMOTE A 

7 BUS B 

8 BUS B- 

 

 
 
 
 
 

 

ISO CAN on the 19 pin connector must be used if the communication has to be isolated. 

For more details about this monitoring device, refer to the Inview user manual. Inview XC has 

slightly different connections but same functionalities. 
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7.4.1 Output Relay Connections 

Each output relay terminal should be connected according to the diagram. A possible 

way of connecting Ground and 12 Vdc in order to get a “0” or a “1” based on the relay 

state. 
 
 

 
0 1 

 

7.4.2 Digital Input Connections 

In digital input terminal, the external voltage should not be applied and it is 

mandatory to connect only like switches. Each output relay terminal should 

be connected according to the diagram. 

 

 

Digital input 
terminal 

 NC  

GN
D 

12 
Vdc 

Co
m 

NO 
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8.  Inview web interface  
Some specific and helpful information for the Inview XC web interface is given in this chapter. 

For more information, read the Inview User Manual: CET - Monitoring - User Manual - Inview - 
EN.pdf (cet-power.com) 

 

8.1 Connection to Inview web interface 

Connect your PC to the ETH port of Inview XC. 

Open the web browser, type the default IP address 

10.250.250.1 in the address field, and press enter. 

Note: Use any of the latest web browsers: Google Chrome, 

Mozilla Firefox, Safari, or Microsoft Edge. 

Inview XC has three logins: Basic, Expert, and Admin. All 

three logins are password protected. The default password 

for all three logins is “1234”. 

An auto-logout feature is available to avoid a user being 

connected all the time. When no action is performed for 

more than 10 minutes, the session will expire and go to 

the login screen. 

 

8.2 Navigating through the interface 

8.2.1 Header 
 

 
        

 
The icons on the header provide quick access to the corresponding pages. 

1 🡪🡪 Home: Clicking on INVIEW logo goes to the home page from any page you are accessing in 

the interface. 

2 🡪🡪 Display the date, time and site name of the system. 

3 🡪🡪 Configuration: Click on  to toggle between Configuration and Widget or 

Dashboard page. 

4 🡪🡪 Alarms: Clicking on  goes to the Alarm page, where active alarms and last events are 

listed. 

5 🡪🡪 Reporting: Clicking on  goes to Reporting page, where Data records and Site details are 

available. 

6 🡪🡪 Administration: Clicking on  goes to the Administration page and provides access to 

many action pages such as User management, Software update, Configuration files, 

Reports, References, Languages selection, Support package, Time management, Events 

log and Licensing. 

7 🡪🡪 User Context: Clicking on  provides the information of login account such as Basic, 

1 2 3 4 5 6 7 
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Expert or Admin, Quick Links to Save Configuration and reboot controller, Website links to 

download software and documents, Device and network information, Change Password 

and Logout. 
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8.2.2 Web page Controls 

Placing or clicking on it performs the corresponding action. 
 

Controls Description 

 

 

 
Filters: Page displays depending upon the filter 
selection. 

 
 
 
 
 
 
 

 
Note: Filter, Edit, 

Rename and Dashboard 

icons are present at 

right side of the web 

page. 

 

 

Page changes to edit mode and the user can 

change the parameters. If any parameter value 

is changed, the edit icon changes to 

modification icon and displays the list. 
 

 

 
Rename the parameter name. 

 

 

 
Select the corresponding parameter to either 

display or not on the Dashboard tab of the 

Advanced View page. 
 

 

 
On-Board help: Provide a short description to help to know about the corresponding 
parameters. 

 

 

 
Page or section expands. 

 

 
Page or section collapse. 

 

 

 
Particular section opens in a new tab. 

 

 

 
Particular section open as a pop-up. 

 
 Drop down list – more options are present. 

 

 
Delete / Clear the corresponding parameter. 
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Controls Description 

 

 

Modifications list: It appears at right side of the “Advanced View” page. This list helps 

the user to overview the changes and can apply the required 

parameters. 

Apply: Clicking on “APPLY” button, the controller 

accepts all the parameter changes in the 

modifications list. 

Apply and Save: Clicking on “APPLY AND 

SAVE” button, the controller accepts all the 

parameter changes in the modifications list and 

saves them in the configuration file. 

Dismiss All: Clicking on “DISMISS ALL” button, 

the controller rejects all the parameter changes 

in the modifications list. 

Clicking on button, the controller rejects 

only the particular modification from the list. 

Note: The number on the icon indicates the number 

of modifications in the list. 

 

 

 
8.3 Inview Licenses 

8.3.1 Basic License 

Pre-installed in all Inview devices, the basic license includes: 
 

Communication with a limited number of CE+T devices 

One type of CE+T Converter, i.e. MPI1600 

CE+T accessories such as MBB without limitation 

Real Time Monitoring and Configuration via Web Interface, including relay mapping 

Access to Inview web interface 

Alarms reflecting the system status 

Events 

Widget View 

Real-Time Data 

Access to controls to send manual setpoints via web interface 

System Remote Interaction for data collecting: Modbus read, email alerts, SNMP traps, NTP 

Modbus TCP/RS485 Read Only 

Email Notification from a certain alarm level (SMTP) 

SNMP V1, V2c, V3 Read Only and Traps 

NTP Protocol 

Cybersecurity Capabilities 

Firewall access 

https with self-signed /standard certificate 
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3 Levels of User Roles 

Basic, Expert, Admin roles give access to different parameters 

Provides basic power management capabilities, including battery regulation: 

UPS for AC loads & UPS for AC and DC loads 🡪🡪 Bidirectionality on DC port 

Battery Regulation Algorithms: CC-CV, Boost, Temperature Compensation, Battery Test, Battery 
Disconnect 

 

 
To know about the available license options, log in to the web interface, go to Advanced View > Site > 
Data > Configuration, and check the ID DA11 in the Controller section. 

 

 
8.3.2 Specific licenses 

Information about more specific licenses can be found in the Inview 

User Manual: CET - Monitoring - User Manual - Inview - EN.pdf (cet-

power.com) 

 

8.4 Network settings 

Go to Advanced View > Site > Configuration 

Enter the network details such as IP address, Firewall settings, NTP time, web server, and applicable 
parameters. 
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8.5 System configuration 

8.5.1 Converter system configuration 

To configure the converter systems, In Advanced View, go to Site > Energy System > Converter 

System > Configuration. 
 

 
The list of related parameters is the following: 

 

ID Name 
Recommended 

values 
(comments) 

System 

 
CF1 

 
Topology 

UPS for AC loads 

UPS for AC & DC loads 

(presence of an MBB is 

mandatory) 

CF6 Number Of Phases 1 or 3 

CF41 Enable Full Remote Control of Converters 
(Advanced) 

True or False 

CF1047 Triangle mode (Advanced) 0 or 1 

CF1049 Start without supervision (Advanced) 0, 1 or 2 

CF1073 Lvd mode (Advanced) 0 or 1 

CF1098 Sleep mode (Advanced) 0 or 1 

Phase 1 

CF121 Configured Converters - 

CF122 Redundant Converters - 

CF123 Nominal Phase Shift (Advanced) 0° 

Phase 2 

CF141 Configured Converters - 

CF142 Redundant Converters - 

CF143 Nominal Phase Shift (Advanced) 120° 

Phase 3 

CF161 Configured Converters - 

CF162 Redundant Converters - 

CF163 Nominal Phase Shift (Advanced) 240° 
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ID Name 
Recommended 

values 
(comments) 

AC-output 

Alarms 

CF111 Saturated: Set 80 % 

CF112 Saturated: Clear 70 % 

Phase 1 

CF124 Nominal Voltage (Advanced) 230 V 

Phase 2 

CF144 Nominal Voltage (Advanced) 230 V 

Phase 3 

CF164 Nominal Voltage (Advanced) 230 V 

Frequency 

CF1016 Nominal Frequency (Advanced) 0, 50 or 60 Hz (50 Hz is 
default) 

Short-Circuit 

CF1034 Short Circuit Threshold Voltage (Advanced) 80V -> 150V 

CF1035 Short Circuit Hold Time (Advanced) 60s -> 1s 

CF1042 Booster 8x Inom (Advanced) 0 or 1 

Power Limitation 

CF1038 Max Current (Advanced) Between 100 and 150 % 

CF1039 Max Power (Advanced) Between 100 and 150 % 

AC-input 

Power Limitation 

CF301 Override Max Consumed Power Timeout 
(Advanced) 

20s 

CF1068 Max Consumed Power (Advanced) -1 

CF1069 AC-in Power Limitation per phase (Advanced) -1 

Alarms 

CF311 Saturated: Set 80 % 

CF312 Saturated: Clear 70 % 

Voltage 

CF1006 Low Start (Advanced) 120 

CF1007 Low Transfer (Advanced) 89 

CF1008 Low Stop (Advanced) 89 

CF1009 High Start (Advanced) 285 V 

CF1010 High Transfer (Advanced) 295 V 

CF1011 High Stop (Advanced) 295 V 

Frequency 

CF1012 Low Start (Advanced) 47.3 Hz 

CF1013 Low Stop (Advanced) 47.0 Hz 

CF1014 High Start (Advanced) 52.7 Hz 
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ID Name 
Recommended 

values 
(comments) 

CF1015 High Stop (Advanced) 53.0 Hz 

Modes 

CF1036 Bravo Priority Input Source (Advanced) 0 % 

CF1037 Synchronization tracking speed (Advanced) -2 

CF1041 Bravo Reg Mode (Advanced) 0 

 
CF1044 

 
Reinjection allowed (Advanced) 

0 (when grid reinjection is not 

allowed) 

1 (pure UPS systems) 

CF1046 Walk in mode (Advanced) 
0 (with grid) 

1 (with genset) 

CF1051 AC 1 stop power (Advanced) 0 

CF1070 Phase compensation (Advanced) 1 

CF1097 Backfeed detection mode (Advanced) 0 

DC 

Bus 1 

CF501 Override Voltage SetPoint Timeout (Advanced) 20s 

CF503 Override Power SetPoint Timeout (Advanced) 20s 

Alarms 

CF511 Saturated: Set 80 % 

CF512 Saturated: Clear 70 % 

Voltage 

CF1000 Low Start (Advanced) 18 V 

CF1001 Low Transfer (Advanced) 16 V 

CF1002 Low Stop (Advanced) 16 V 

CF1003 High Start (Advanced) 30 V 

CF1004 High Transfer (Advanced) 32 V 

CF1005 High Stop (Advanced) 32 V 

CF1072 V DC Low Stop charger (Advanced) 
0 V (no critical DC 

loads) 10 V (with 

critical DC loads) 

Fallback 

CF1066 Charging Voltage 26.8 V 

CF1067 Charging Power See help 

CF1074 Maximum Voltage Increment Rate See help 

Modes 

CF1071 Sierra Mode (Advanced) 1 

CF1087 Slope (Advanced) 0 W/V 

Hidden 

CF1084 Temperature Derating Mode (Advanced) 0 
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8.5.2 DC system configuration 

The following configuration is to be used with classical lead-acid batteries (not a smart battery, no 

BMS), without DC load, without an LVD (Battery Disconnect), without the configuration for battery 

tests, with the configuration for battery boost, without temperature compensation and without MBB 

for battery measurements. 

Information about more specific battery configurations can be found in the 

Inview User Manual: CET - Monitoring - User Manual - Inview - EN.pdf (cet-

power.com) 

To configure the DC System, go to Advanced View > Site > Energy System > DC System > 
Configuration. 

In the DC Bus section, set the parameters depending upon the DC voltage. The below page is 
configured to 48 Vdc. 

 

 

 
The list of related parameters is the following: 

 

ID Name 
Recommended 

values 
(comments) 

DC Bus 

Alarms 

CF50 Voltage Low: Set 20.50 V 

CF51 Voltage Low: Clear 21.00 V 

CF52 Voltage High: Set 28.50 V 

CF53 Voltage High: Clear 28.25 V 

Battery 

CF90 Presence True 

Measurement Source 

CF100 Voltage (Advanced) Autodetected 

CF101 Current (Advanced) Modules 

Characteristics 

CF102 Type Lead-Acid 

CF103 Number of Cells 12 

CF104 String Capacity - 

CF105 Number of Strings 1 

Autonomy 

CF106 Peukert Number See help 

CF107 Max Depth of Discharge for Estimation See help (100.00 by default) 
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ID Name 
Recommended 

values 
(comments) 

Temperature alarms 

CF121 Alarm Low Threshold Without MBB and 

temperature measurement, 

these alarm threshold 

cannot be taken into 

account. 

CF122 Alarm High Threshold 

CF123 Alarm High Hysteresis 

Battery charging 

Voltage (Float) 

CF111 Voltage Per Cell 2.26 V 

CF112 Source Configuration 

Current Limitation 

CF113 Enabled True (by default : False) 

CF114 Current Limit 
Set according to the 

battery’s datasheet 

CF115 Source Configuration 

Start/stop criteria 

 
CF126 

 
Disable Charge When Too High 

Without MBB and 

temperature measurement, 

this criteria cannot be taken 

into account 

Temperature Compensation 

 
CF151 

 
Enabled 

False (Without MBB and 

temperature measurement, 

this compensation cannot be 

taken into account) 

Boost 

CF201 Enabled False 

Battery test 

CF251 Enabled False 

Battery Disconnect 

 
CF301 

 
Presence 

False (Without a physical 

LVD and relay 

configuration, it is not 

possible to use this 

feature) 
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8.5.3 Widget configuration 

Widgets of different sorts are available. Up to 20 widgets can be configured on the home page. The 

configuration will appear on the web interface (toggle Advanced View). 
 

 

 

 

 
Clicking on any widget displays the corresponding details on right side of the page. 
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Perform the following step for Widgets configuration: 

1. Assigning number of widgets: Go to Advanced View > Energy System > Description > 

Connected Assets. Click the edit icon and enter the number of assets connected to the system 

in the ID DE500. Click “Apply and Save” to apply changes. 

For example, the Sierra System has four assets: AC Input, Battery, AC Load and DC Load. 

So, in the below screenshot, the number 4 is entered. 

Note: As soon as you start customizing your assets, the default one will be deleted, and you have 

to create all the assets you want to display. You can get the default assets back by setting DE500 

to 0 again. 

2. Widget settings: Go to Asset 1 in the ID DE510, select the type of widget and enter the 

desired name for the widget in ID DE511. 
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A) Similarly, configure for other remaining Assets. In the below screenshots, Assets 1, 2, 3 and 4 

are assigned for AC Input, Battery, AC Loads and DC Loads, respectively. 

 

B) Toggle the Advanced view switch and verify all assigned widgets appear on the home page. 
 

 
In Widget settings, the type and name are assigned to the widget, which is not connected 

to the appropriate measurements. Follow the next step for connections. 
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Go to Advanced View > Converter System > Description > Asset Connections. 

 

■ AC Outputs: In the ID DE501, Select the Asset name from the list connected to the 
system’s AC Output. 

■  AC Inputs: In the ID DE502, Select the Asset name from the list connected to the 
system’s AC Input, such as Grid, Genset, etc. 

■  DC: In the ID DE503, Select the Asset name from the list connected to the system’s 
DC Input, such as Rectifier, MPPT, etc. No DC input is connected to the system, so in 
the above screen shot, it is left blank. 

■ DC Load and Battery: Go to Advanced View > DC System > Description > Asset 
Connections. 

 

 

■ DC Load: In the ID DE504, Select the Asset name from the list connected to the system’s 
DC Output. 

■ Battery: In ID DE505, Select the Asset name of the Battery from the list connected to 
System. 
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■  Toggle the Advanced view switch and verify all assigned widgets are configured 
correctly on the home page. 
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9.  Finishing  
• If cabinets are used, make sure that they are properly fixed to the cabinet/floor and connected 

to Ground. 

• Make sure that all DC and AC input breakers are switched OFF. 

• Make sure that all cables are according to recommendations and local regulations. 

• Make sure that all cables are strained relieved. 

• Make sure that all breakers are according to recommendation and local regulations. 

• Make sure that DC polarity is according to marking. 

• Re tighten all electrical terminations. 

• Make sure that no converter/controller positions are left open. 

• Cover empty converter positions with blanks. 

• Make sure that the Remote ON/OFF is appropriately wired according to local regulations. 

• Make sure that the point of AC supply meets local regulations. 
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10.  Commissioning  
The DC breaker is a protection device. Modules are plugged in a system and DC breaker is then 

engaged. Please make sure the corresponding DC breaker is engaged in the ON position. Failure 

to observe this rules will result not to have all module operating when running on DC and have 

module failure when AC input recover from fault condition. 

Installation and commissioning must be done and conducted by trained people fully authorized to 

act on installation. It is prohibited to perform any isolation test without instruction from 

manufacturer. 

Equipments are not covered by warranty if procedures are not respected. 
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10.1 Check list 

 

DATA 

Date 

Performed by 

Site 

System serial number 

Module serial numbers 

 

 

 

Inview XC (RIPE) Serial number 

ACTION OK/ N.OK 

Check the commercial AC voltage before closing the AC input breaker.  

Switch ON the commercial AC  

Check the DC power supply and switch ON the DC breakers (Ensure the DC Polarity)  

Check if converters are working (Green led)  

Check output voltage (on bulk output or on breaker)  

Power ON if more modules are connected in parallel (3to 6 modules) one by one  

Check if all converters are working properly  

Check if system has no alarm (Disable the alarm if any)  

Set the Battery parameters (as per OEM datasheet) mainly on charging voltage and current  

Check the Battery charging status  

Check the Battery discharging status by disconnecting the AC Input power supply  

Read configuration file and review all parameters. Some parameters should be adapted 

according to the site condition. 

 

Test on load (if available)  

  

ALARM 

Switch ON AC input and DC input and check that no alarm are present  

Switch OFF AC input (commercial power failure) and check the alarm according to the 
configuration 

 

Check the different digital input according to the configuration (when used)  

If the converters are working in normal condition, save the configuration file and clear all the 
event logs 
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11.  Trouble Shooting and Defective Situations 
Fixing 

11.1 Trouble Shooting 

Converter module does not power up: Check AC input present and in range (AC breakers) 

Check DC input present and in range (DC 

breakers) Check that the converter is properly 

inserted 

Remove converter to verify that slot is not damaged, check 

connectors Check that module(s) is (are) in OFF state 

Check for loose terminations 
 

 
Converter system does not start: Check that Inview is present and properly connected 

Check remote ON/OFF 

terminal Check the 

configuration and setting 

Check threshold level 

 
Converter only run on AC or DC: Check AC input present and in range (AC breakers) 

Check DC input present and in range (DC 

breakers) Check the configuration and setting 

Check threshold level(s) 
 

 
No output power: Check output breaker 

 

 
All OK but I have alarm: Check the type of event and log file in the controller 

 

 
No alarm: Check relay delay time of alarms in the 

controller Check configuration file 
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11.2 Defective modules 

• A repair request should follow the regular 

logistics chain: End-user => Distributor => 

CE+T Power. 

• Before returning a defective product, a RMA number must be requested through the 

http://my.cet-power.com extranet. Repair registering guidelines may be requested by email 

at repair@cet-power.com. 

• The RMA number should be mentioned on all shipping documents related to the repair. 

• Be aware that products shipped back to CE+T Power without being registered first will not be 

treated with high priority! (Label shown here is only for representation) 
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12.  Maintenance  
Maintenance should be performed by properly trained people. 

 

12.1 Access Inview XC (RIPE) with Laptop 

• Download system LOG FILE and save 

- Analyze log file and correct errors 

• Download system CONFIGURATION FILE and save 

- Check/correct configuration file according to operation conditions 

- Check/correct alarm configuration 

• Check module internal temperature for deviation between modules 

- Temperature deviation may indicate build up of dust. Clean the module by air suction 

blower or vacuum cleaner. 

• Check module/system load 

• Check/Correct inverter mapping (DC group/AC group/ Address) 

 

12.2 Manual check 

• Check voltages of AC input, DC input, AC output and DC output using the multi-meter 

• Replace door filter if more dust is accumulated. 

• Take a snap shot of the cabinet and site condition 

 

12.3 Optional 

• With an infrared camera check termination hot spots 

- Tighten terminations 

 

12.4 Manual By-Pass 

• Make sure AC input source is available during MBP operation. Otherwise the LOAD will be 
affected. 
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13.  Defective modules  
For Service 

• Check Service Level Agreement (SLA) of your vendor. Most of the time they provide 

assistance on call with integrated service. If such SLA is in place, you must call their 

assistance first. 

• If your vendor doesn’t provide such assistance (*) you may contact CE+T through email: 

■ USA and Canada: tech.support@cetamerica.com 

■ Rest of the world: customer.support@cet-power.com 

(*) CE+T will redirect your call to your vendor if he has such SLA in place. 
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14.  Appendix  

14.1 Modules - Parameter List 

With Inview, you can access the modules’ parameter list and descriptions. Refer to the Inview user 

manual to access the Inview web interface - https://datasheet.cet-power.com/CET - Monitoring - 

User Manual - Inview - EN.pdf. 

If you want to have an overview of standard systems’ parameters, you can also view the parameters 

in our Monitoring Emulator - https://www.cet-power.com/en/monitoring-emulator/. 

NOTE! Do not hesitate to use the help buttons to get more information about the parameters. 
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